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Ficha de instalación 

Descripción Programa gratuito que permite realizar partituras.   

Obtención Puede descargarse de su página oficial http://www.finalemusic.com/ (6.27 Mb). 

Versión 2004.r1 

Licencia Freeware (gratuito). 

Observaciones 
Tiene una versión plus (de pago) que permite importar archivos MIDI y exportar 
las partituras como archivos MIDI. Es el hermano menor de toda la familia de 
productos de edición de partituras de Finale (PrintMusic, Allegro, Finale,...).  

Para poder descargar el programa nos piden que nos registremos como usuarios. Los pasos son 
los siguientes: 

• Nos dirigimos a la web http://www.finalemusic.com/ y buscamos el enlace que nos lleve 
hasta el programa NotePad.  

 

• En la página que nos surge elegimos la plataforma deseada (Windows).  

 

• Como no estamos registrados como usuarios debemos crear previamente una cuenta así 
que pulsaremos en el enlace Create Account.  

 

• En la página que surge nospedirán que introduzcamos una dirección de e-mail y que 
seleccionemos nuestro país del listado. Después pulsaremos sobre el botón Continue.  
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• Nos surgirá una nueva página donde ya aparecerá nuestra dirección de e-mail y debemos 
introducir la contraseña (Password) que nos enviaron por correo electrónico (no tarda 
mucho en recibirse). Pulsamos a continuación el botón Enter.  

 

• Aparece una página con una breve encuesta. La rellenamos y pulsamos en el botón 
Submit Survey.  

 

• Nos aparece una nueva pantalla con el enlace que debemos pulsar para iniciar la descarga 
y un número de serie que nos pedirá al realizar la instalación del programa (este número 
de serie también lo enviarán por e-mail). Pulsaremos sobre el enlace para iniciar la 
descarga.  
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Una vez concluida la descarga, la instalación del programa es sencilla: 

 Hacemos doble clic en el icono de instalación  y se iniciará el proceso de instalación. 
Pulsamos en el botón Next>. 
  

 
 

 Nos recomienda que salgamos de cualquier programa que tengamos funcionando antes de 
continuar con la instalación. Una vez seguida esta recomendación pulsamos el botón Next>. 
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 Nos pide que leamos la Licencia de Uso. Pulsamos sobre el botón Yes. 
 

 
 

 Se indica la carpeta donde se instalará el programa. Pulsamos sobre el botón Next>. 
 

 
 



 SONIDO Y MÚSICA CON ORDENADOR 
 

______________________________________________________________________ 
 MÓDULO 2: Aplicaciones prácticas – Unidad 7: Partituras: NotePad 2004 5 

Especifica la carpeta (y el nombre que recibirá) donde se situarán los iconos de acceso al 
programa. Pulsamos en el botón Next>. 
 

 
 

 La siguiente pantalla nos resume las opciones que hemos seleccionado para realizar la 
instalación. Pulsamos en el botón Next>. 
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Breve descripción  

 

En esta breve descripción del programa nos limitaremos a mostrar las principales zonas que 
podemos observar en la pantalla principal: 

Menú principal   

Barras de herramientas 

• De utilidades de archivo  
 

• Principal  
 

• De reproducción  
 

• De entrada simple de notas  
 

• De entrada simple de silencios  
 

• De articulación  

Partitura. Se muestra tal y como se va a imprimir. Puede modificarse la orientación y la 
escala. 
 

Barra de localización. Nos muestra cuál de las cuatro capas que pueden utilizarse para 
escribir notas está activa y la página de la partitura en que nos encontramos. 
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Caso práctico 18: Introducir partitura 

Introduciremos la partitura de un arreglo para piano del tema Greensleeves. Imprime el 
ejemplo en pdf para realizar este caso práctico. 

  Iniciaremos el programa NotePad. Pulsamos en el botón y seleccionamos 
Todos los programas>Finale NotePad 2004>Finale NotePad 2004 o en el acceso directo 
que hayamos creado en el escritorio. La primera vez que arranquemos el programa nos pedirá que 
introduzcamos el número de serie que obtuvimos durante la descarga (y que también nos 
enviaron por e-mail). Una vez introducido pulsamos el botón Register Now!  

 

 Se inicia un asistente: primer paso. Para comenzar la introducción de una partitura es muy 
útil el asistente que se inicia automáticamente al arrancar el programa. Lo primero que nos pide 
es:  

• El título de la composición: escribiremos Greensleeves.  
• El nombre del compositor: la obra es anónima pero podemos aprovechar para poner el 

nombre del transcriptor (tu nombre).  
• El tamaño del papel en que se va a imprimir: seleccionaremos el tamaño A4.  
• La orientación del papel: seleccionaremos la orientación vertical (Portrait).  
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Pulsamos luego en el botón Siguiente>. 
 

 
 

 Asistente: segundo paso. Seleccionamos el instrumento para el que vamos a realizar la 
partitura. Pulsamos primero en los instrumentos de teclado (Keyboard) y, dentro de los que nos 
surgen a la derecha, seleccionamos piano y pulsamos en el botón Add> para que se añada. 
Pulsamos luego en el botón Siguiente>. 
 

 
 
 

Partitura para más instrumentos/voces. Si la partitura fuese para más instrumentos y/o 
voces podríamos ir seleccionándolos y añadiéndolos como hicimos con el piano. Si nos 
equivocamos al añadir alguno y queremos quitarlo solo debemos seleccionarlo y pulsar en el botón 
Remove>. Por otro lado, el orden que los instrumentos ocuparán en la partitura será el mismo 
que aparece en la columna donde se muestran los instrumentos que hemos ido añadiendo. Si 
queremos variar ese orden hay que seleccionar cada instrumento y desplazarlo hacia arriba o 
hacia abajo, empleando las flechas que se encuentran a la derecha de dicha columna. Pero 
debemos tener en cuenta que este programa tiene establecido un límite de ocho pentagramas por 
sistema. 
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 Asistente: tercer paso. Seleccionaremos el compás (6 por 8 en este caso) y la tonalidad y el 
modo de Mi menor (E Minor). Pulsamos a continuación en el botón Finalizar. 
 

 
 

Nos aparecerá una partitura en blanco con las opciones establecidas anteriormente 
 

 
 

 Comprobaciones previas. Antes de comenzar nos vamos a asegurar de lo siguiente:  

• El menú View tendrá seleccionado Scale View to 100% (si quisiéramos que la partitura 
se mostrase más grande o más pequeña seleccionaríamos un porcentaje de escala mayor 
o menor, respectivamente).  

• En el menú Options seleccionaremos Measurement Units-Centimeters, de este modo 
se utilizará como unidad de medida el centímetro y no la pulgada).  

• En el menú Simple nos aseguraremos de que estén seleccionadas las siguientes 
opciones:  
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o Check for Extra Notes: detecta si intentamos introducir una nota cuyo valor 
excede al que queda libre dentro del compás e impide que la introduzcamos 
(claro que si quisiéramos elaborar ejercicios para los alumnos en los que 
introdujésemos errores de modo voluntario para que los detectasen, podríamos 
no seleccionar esta opción y así nos permitiría introducir cualquier nota.  

o Fill With Rest at End of Measure: rellena con silencios aquellos compases que 
dejemos incompletos.  

o Playback Notes on Entry: hace sonar la notas que vamos introduciendo.  

 Vamos guardando. Para evitar posibles disgustos conviene que guardemos la partitura con lo 

realizado hasta ahora. Para ello pulsamos en el botón (también podemos ir al menú 
File>Save o pulsar Ctrl+S) y seleccionar la carpeta donde lo vamos a guardar. Lo guardaremos 
con el nombre de greensleeves.MUS y cada cierto tiempo conviene que se vayan guardando los 
cambios realizados y, en caso de algún problema con el ordenador, no se pierda todo el trabajo 
realizado. 
 

 Introducimos las notas. Seleccionamos Simple Entry Tool (herramienta de entrada simple). 
 

 
 

Para introducir las notas y los silencios utilizaremos las correspondientes barras de herramientas, 
seleccionando la figura que proceda en cada caso: 
 

 
 

 
 

Cuando se selecciona una figura musical el cursor se transforma en esa figura o silencio y 
debemos colocarla en el lugar del pentagrama que nos interese. Además hay que tener presente 
lo siguiente: 

• Para introducir figuras con puntillo debemos seleccionar previamente tanto a la figura 
como al puntillo (luego cuando queremos introducir otra figura debemos recordar 
deseleccionar el puntillo). Por ejemplo, si queremos introducir una corchea con puntillo 
debemos seleccionar:  

 

• Para introducir notas con alteraciones accidentales (que no estén ya en la armadura de la 
tonalidad seleccionada) debemos seleccionar previamente tanto a la figura como la 
alteración deseada (luego cuando queremos introducir otra figura que no tenga esa 
alteración debemos acordarnos de deseleccionarla). Por ejemplo, si queremos introducir 
una negra que tiene un sostenido debemos seleccionar:  

 



 SONIDO Y MÚSICA CON ORDENADOR 
 

______________________________________________________________________ 
 MÓDULO 2: Aplicaciones prácticas – Unidad 7: Partituras: NotePad 2004 11 

• Para introducir notas con ligadura de unión o con tresillo debemos seleccionar 

previamente tanto a la figura como el botón correspondiente de ligadura o de tresillo 

siguiendo un proceso similar al explicado en los dos casos anteriores.  
• Para borrar una figura o silencio debemos seleccionar la goma y pulsar sobre la figura o 

silencio que queremos eliminar.  

 
 

Con estas indicaciones ya podemos ir introduciendo todas las notas de la partitura. Pueden serte 
de utilidad la siguientes aclaraciones: 

• En el primer compás debemos introducir los silencios previos a la anacrusa. Estos silencios 
pueden ocultarse en versiones del programa superiores, pero aquí no nos queda más 
remedio que introducirlos.  

• Los compases 2 y 3 son iguales que los compases 6 y 7, así que podemos pulsar en la 

herramienta de selección y con el puntero encuadrar los compases 2 y 3 y hacer clic 
para seleccionarlos:  

 

Una vez seleccionados podemos copiarlos (Edit>Copy o Ctrl+C) y pegarlos 
(Edit>Paste o  Ctrl+V) en unos compases previamente seleccionados con el 
cursor (el número de compases seleccionados para pegar el fragmento de música 
debe ser igual al número de compases copiados). Pero también podemos pulsar 
sobre los compases seleccionados que queremos copiar, arrastrarlos y soltarlos 
sobre los compases sobre los que queremos copiarlos: 
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Al soltar los compases aparecerá una ventana que nos pedirá que establezcamos 
cuántas veces queremos que se copien esos compases (por defecto una sola vez). 
Lo dejaremos así y pulsaremos sobre el botón OK. 

 

Esto ahorra tiempo al no tener que volver a introducir de nuevo toda la música. 
También podemos utilizarlo por ejemplo con los compases 10 y 11 que son 
iguales que los compases 14 y 15, y el 8 igual que el 16. 

 Eliminamos los compases vacíos. Después de introducir todas las notas observamos que 
nos quedan toda una serie de compases en blanco. Para eliminarlos debemos seleccionar la 
herramienta de compás (Measure Tool): 
 

 
 

A continuación, con el cursor seleccionamos los compases en blanco y vamos al menú 
Measure>Delete (con esta misma herramienta podemos añadir o insertar nuevos compases si 
nos hiciesen falta). 
 

 Guardamos el archivo. Volvemos a pulsar en el botón para guardar el archivo con la 
partitura completa. 
 

 Escuchamos la partitura. Podemos escuchar la música que vamos introduciendo en 
cualquier momento. Para escucharla usaremos los controles de reproducción: 
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Caso práctico 19:  Modificar partitura 

Modificaremos una partitura ya existente. Imprime el ejemplo en pdf para realizar este 
caso práctico. 

  Iniciaremos el programa NotePad. Pulsamos en el botón y seleccionamos 
Todos los programas>Finale NotePad 2004>Finale NotePad 2004 o en el acceso directo 
que hayamos creado en el escritorio. Comenzará automáticamente el asistente para iniciar una 
nueva partitura pero pulsaremos sobre el botón Cancelar.  

 

 Abrimos el archivo. Para abrir el archivo de la partitura que vamos a modificar iremos al 
menú File>Open y buscaremos la carpeta donde se encuentra para seleccionarlo y abrirlo. 

 Guardar como. Para que todas las modificaciones que hagamos no afecten al archivo original 
guardaremos el archivo de la partitura con otro nombre. Iremos al menú File>Save As... 
seleccionaremos una carpeta y lo guardaremos como greensleeves2.MUS  

 Cambio de tonalidad. Lo primero que haremos será transportar la partitura para que la 
melodía que se interpreta con la mano derecha del piano pueda también ser interpretada, por 
ejemplo, por una flauta dulce, y sin muchas alteraciones. La mejor alternativa parece que puede 
ser subirla una 4ª, justa por lo que de la tonalidad de Mi menor pasará a la tonalidad de La menor. 
El modo de hacer esto consiste en seleccionar la herramienta de armadura (Key Signature Tool).  

 

A continuación, nos saldrá una ventana en la que seleccionaremos la tonalidad de La menor (A 
Minor), dejaremos la tonalidad menor (Minor Key) y la opción de que las notas se desplacen hacia 
arriba (Move existing notes Up). Pulsaremos sobre el botón OK.  
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La partitura automáticamente desplazará todas las notas al lugar correspondiente y colocará la 
armadura y las alteraciones accidentales que procedan.  

 

 Introducimos una letra. Debajo de la melodía de la mano derecha introduciremos el texto de 
la letra de la canción. Seleccionaremos la herramienta de letra (Lyrics Tool).  

 

Al seleccionar un pentagrama se sitúa a su izquierda un triángulo que puede desplazarse hacia 
arriba y hacia abajo para establecer la línea de base del texto que vamos a introducir (esta 
posición puede variarse en cualquier momento).  

 

Si pulsamos encima de la primera nota aparecerá justo debajo un cursor para poder comenzar a 
escribir el texto. Para saltar a la nota siguiente sólo hay que pulsar en la barra espaciadora (si 
cambiamos de parabra) o sobre el guión "-" (cuando viene otra sílaba de la misma palabra).  
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 Introducimos texto. Además de la letra de las canciones podemos introducir o modificar 
otros textos. Para eso tenemos que seleccionar la herramienta de texto (Text Tool).  

 

Al lado de los textos introducidos con anterioridad aparecerá un cuadradito. Por ejemplo aparecerá 
sobre el título de la partitura:  

 

Si queremos seleccionar ese texto pulsamos sobre el cuadradito que se rellenará con otro más 
pequeño y negro para indicarlo. Si quisiésemos borrar ese texto tendríamos entonces que pulsar la 
tecla Supr. También podemos pulsar sobre el cuadradito y arrastrarlo para cambiar la posición del 
texto en la partitura, o hacer doble clic sobre el para modificar el texto.  

Para insertar nuevo texto hacemos doble clic sobre el lugar de la partitura donde queremos 
insertarlo (aunque luego podemos cambiar u posición). Introduciremos por ejemplo lo siguiente:  

• "(Voz y flauta dulce)" que lo introduciremos al comienzo de la partitura, sobre el 
pentagrama de la mano derecha del piano, para indicar que es la misma melodía que 
puede cantar la voz con el texto y que también puede tocarse con la flauta dulce.  

 

• "rit..........." que lo situaremos al final de la partitura en el penúltimo compás para indicar 
un ritardando.  
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 Introducimos matices. Podemos añadir matices, articulaciones, etc. para lo cual 
seleccionaremos previamente la herramienta de articulación (Articulation Tool).   
 

 
 

Una vez seleccionada aparecerán unos cuadraditos en todos los elementos que hayan sido 
introducidos con esta herramienta y podemos utilizarlos de igual modo que acabamos de comentar 
con la herramienta de texto para seleccionarlos, eliminarlos o cambiar su posición.  
 
Para introducir uno nuevo haremos doble clic sobre la cabeza de una nota en el lugar donde 
queremos situarlo. Nos aparecerá una ventana donde seleccionaremos el matiz que queremos 
introducir y pulsaremos en el botón Select.  
 

 
 
Por ejemplo:  

• Un mezzopiano (mp) al inicio de la partitura:  
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• Un forte al comienzo del estribillo:  

 

• Un calderón en la nota final:  

 

 Otros añadidos. También podemos insertar, por ejemplo, indicaciones de repetición  o 

ligaduras de expresión y reguladores . Prueba y experimenta con ellos pero no te olvides de 
guardar previamente todo lo realizado hasta ahora.  
 

 Guardamos el archivo. Volvemos a pulsar en el botón  para guardar el archivo con la 
partitura completa. 
 

 Escuchamos la partitura. Podemos escuchar la música que vamos introduciendo en 
cualquier momento. Para ello utiliza los controles de reproducción: 
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 Imprimimos la partitura. Para imprimir pulsamos el botón  o vamos al menú 
File>Print (Ctrl+P). Nos surgirá una ventana donde podremos establecer la calidad de impresión 
en puntos por pulgada (dpi: dots per inch). Seleccionamos 600 dpi y pulsamos en el botón OK.  
 

 
 
 

Introducir un fragmento de partitura en un archivo de texto. Al elaborar unos apuntes o 
unos ejercicios de música es posible necesitar combinar texto y partitura. Para eso lo que 
podemos hacer son capturas de pantalla con los fragmentos de la partitura que deseamos 
introducir y pegarlas en el lugar deseado dentro del procesador de texto. 
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Caso práctico 20:  Pasar a WAV 

Vamos a grabar la reproducción de la partitura como un archivo WAV. 

  Iniciaremos el programa Audacity. Pulsamos en el botón y seleccionamos 
Todos los programas>Audacity o en el acceso directo que hayamos creado en el escritorio.  

 Establecemos las preferencias de grabación. Vamos al menúArchivo>Preferencias... y 
en la pestaña Audio E/S dejamos como dispositivo de reproducción y de grabación la opción 
Asignador de sonido de Microsoft -Output y como canales vamos a seleccionar 2 (Estéreo).  

 

En las pestañas Calidad y Formatos de archivo vamos a dejar todos los valores establecidos por 
defecto, que se vienen a corresponder con los estándares de la calidad de CD. 
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 Seleccionamos el dispositivo de entrada: Stereo Mix  

 

  

No todas las tarjetas de sonido son iguales. Conviene recordarlo y repasar lo dicho en el 
apartado dedicado a El sonido en el sistema operativo. En este caso (con una tarjeta integrada 
en placa base Realtek AC 97) podríamos haber empleado como dispositivos Stereo Mix o Mono 
Mix, pero dado que queremos realizar una grabación en estéreo seleccionamos Stereo Mix. 

 Establecemos el volumen de grabación o entrada y de reproducción o salida. En 
principio, el volumen de grabación o entrada lo pondremos al máximo o cerca del máximo. 

 

Por otro lado, también controlaremos el volumen de reproducción o salida (es decir, del 
dispositivo de salida del sonido, que en esta tarjeta de sonido concretamente se denomina Onda). 
Cuando grabamos desde micrófono este volumen lo controlamos alejándonos de él o hablando con 
menos volumen, pero en este caso sólo podemos hacerlo mediante el control. 

 

Si este volumen es demasiado alto y produce saturación la grabación (además de escucharse 
claramente distorsionada) puede ofrecer el siguiente aspecto: 

 

Mientras que si el volumen de reproducción o salida es correcto tendrá este otro: 
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Los controles de volumen de entrada y de salida del programa Audacity están vinculados a 

los correspondientes (según la selección hecha en cuanto al dispositivo de entrada: ver paso 3) 
de la tarjeta de sonido. En realidad lo que hacen es ahorrarnos tener que hacer esa operación 
directamente sobre los controles de volumen y grabación de la tarjeta de sonido, tal y como 
tuvimos que hacer al trabajar con la Grabadora de sonidos del sistema operativo. 

 

 Abrimos el archivo de la partitura. Con el programa NotePad abrimos el archivo 
greensleves2.MUS creado en la práctica anterior.  

  Establecemos la velocidad de reproducción. Desde la barra que contiene los controles de 
reproducción podemos establecer la velocidad de reproducción a partir de una indicación 
metronómica: 

 

• En primer lugar, dado que estamos en un compás de 6 por 8, estableceremos la figura 
que equivale a una parte del compás (la negra con puntillo):  

 

• A continuación, estableceremos cuántas de esas figuras (partes del compás) se realizarán 
por minuto (escogeremos una velocidad moderada así que introduciremos 90). Para ello 
podemos emplear las fechas o introducir el número en la casilla.  

 
 

No podemos controlar más posibles parámetros de reproducción (al menos con este programa 
gratuito). El sonido del instrumento se seleccionará automáticamente de entre los sonidos que 
produzca el sintetizador de nuestra tarjeta de sonido.  
 

Utilización de un secuenciador. Esta versión del programa no lo permite (habría que adquirir la 
versión superior NotePad Plus), pero si exportásemos la partitura como archivo MIDI entonces 
podríamos abrirlo desde cualquier secuenciador y aplicar todos los cambios y modificaciones que 
permiten los secuenciadores y que pueden ser mucho más potentes que los que se pueden realizar 
desde los propios editores de partituras (aunque las versiones más profesionales de los editores 
de partituras incluyen funciones que los convierten en seudosecuenciadores). Podrían así 
asignarse canales midi, utilizar instrumentos virtuales, utilizar la mesa de mezclas del 
secuenciados, etc. 
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 Iniciaremos la grabación e inmediatamente la reproducción. Para iniciar la grabación 
simplemente iremos al programa Audacity y pulsaremos sobre el botón de grabación: 
 

 
Inmediatamente nos dirigiremos al programa NotePad y pulsaremos sobre el botón de 
reproducción: 

 
 

La grabación se irá realizando. Si queremos verla podemos regresar al programa Audacity. La 
pista audio donde se realiza la grabación se genera automáticamente y está dividida en dos partes 
(una por cada canal). Al principio sólo se verá una línea azul horizontal en el centro del área 
reservada a cada canal. Esa es la representación que tiene el silencio que se ha grabado en el 
lapso de tiempo que hemos tardado en iniciar la reproducción del archivo. Luego veremos la 
representación del sonido grabado en la pista de audio: 
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 Finalizada la reproducción del archivo pararemos y comprobaremos la grabación.  
 

 
 

Para asegurarnos de que todo se ha grabado correctamente podemos escuchar la grabación 
pulsando en el botón de reproducción.  
 

 
 

Si la grabación ha salido distorsionada revisaremos el volumen de entrada, tal y como 

comentamos en el paso 4. Podemos eliminar la pista grabada ( ). Y a continuación deberíamos 

repetir los pasos 7 y 8. 
 

  Si todo ha ido correctamente conviene que guardemos el archivo antes de editarlo. 

Ahora iremos al menú Archivo>Guardar Proyecto Como... . Seleccionaremos la carpeta 
editando y le pondremos de nombre el mismo que al archivo de la partitura solo que la extensión 
será .aup: greensleeves2.aup (este tipo de archivo es solo interpretado por el programa 
Audacity y contiene toda la información utilizada por el programa además de la grabación 
propiamente dicha). 
 

 Eliminaremos el silencio del principio y del final de la grabación. Aplicaremos lo 

explicado en el paso 3 del caso práctico 7.  
  

 Exportamos la grabación al formato WAV . Si ya tenemos una grabación aceptable del 
archivo, solo nos restaría exportarla al formato WAV. Para eso iremos al menú Archivo>Exportar 

como WAV (o Export As WAV). Lo guardaremos en la carpeta editando (en este caso con el 
nombre greensleeves2.wav). 
 

 

 

Lo aprendido en estos casos prácticos puede tener las siguientes aplicaciones 
didácticas:  
 
1. Elaboración de partituras o ejemplos musicales. Tanto para las prácticas instrumentales 
y/o vocales como para el análisis musical (elementos de lenguaje musical, características 
estilísticas, ...). Para la elaboración de apuntes sobre lenguaje musical, historia de la música, etc. 
2. Aprendizaje de la escritura musical. El alumno puede convertirse también en el 
protagonista de la utilización del editor de partituras y de este modo poner en práctica los 
conceptos aprendidos sobre la escritura musical al transcribir o elaborar alguna partitura.
3. Ejercicios de "composición" musical. La creación de melodías, acompañamientos, 
esquemas rítmicos, etc por parte de los alumnos a partir de pautas claras por parte del profesor 
puede encontrar una gran herramienta en el editor de partituras puesto que el alumno no tendría 
que limitarse a realizarlo de modo gráfico sino que también puede escuchar el resultado. 

 

 

 


